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Preface

Using Oracle Eloqua Cloud Adapter describes how to use the Oracle Eloqua Cloud
adapter in your SOA composite applications and Oracle Service Bus business services.

Topics:

• Audience

• Documentation Accessibility

• Related Resources

• Conventions

Audience
Using Oracle Eloqua Cloud Adapter is intended for users who want to create, deploy,
test, and monitor applications that use the Oracle Eloqua Cloud adapter.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/
topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/
topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Related Resources
For more information, see these Oracle resources:

• Developing SOA Applications with Oracle SOA Suite

• Administering Oracle SOA Suite and Oracle Business Process Management Suite

• Administering Oracle Service Bus

• Understanding Technology Adapters

v

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
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Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.

vi



1
Introduction to Oracle Eloqua Cloud

Adapter

This section introduces Oracle Eloqua Cloud adapter.

Topics

• Differences Between Using Oracle Cloud Adapters in the Cloud and On-Premises
Environments

• Oracle Eloqua Cloud

• Installing the Cloud Adapters

• Performing Postinstallation Configuration Tasks

• Disabling Hostname Verification

• Obtaining the Authentication Credentials

• Unsupported Features

• Designing an Integration with the Adapter Configuration Wizard

Differences Between Using Oracle Cloud Adapters in the Cloud and On-
Premises Environments

There may be differences between using Oracle cloud adapters in the cloud and on-
premises environments that impact the information described in this guide.

For information about differences, see Using Oracle SOA Suite Cloud Service and 
Known Issues for Oracle SOA Suite Cloud Service.

Oracle Eloqua Cloud
The Oracle Eloqua Cloud adapter enables you to create an integration with an Oracle
Eloqua Cloud application.

Oracle Eloqua Cloud provides cloud-based marketing software that delivers
marketing automation for industries such as finance, health, media, real estate, sports,
entertainment, and so on. Oracle Eloqua Cloud simplifies marketing procedures by
delivering leads targeted to new customers. Oracle Eloqua Cloud helps manage and
organize marketing segmentation and marketing workflow.

The Oracle Eloqua Cloud adapter accelerates integrations between customer
relationship management (CRM) and Oracle Eloqua Cloud systems. The Oracle
Eloqua Cloud connection addresses the synchronization of account and contact data
from CRM to Oracle Eloqua Cloud systems.
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For more information, see Configuring Oracle Eloqua Cloud Properties.

Installing the Cloud Adapters
See the README.txt available with the patch for instructions on installing the cloud
adapters.

After you complete adapter installation, perform the tasks described in Performing
Postinstallation Configuration Tasks.

Note:   For information about supported versions and platforms, see the
release certification matrix at Supported System Configurations.

Performing Postinstallation Configuration Tasks
You must perform postinstallation configuration tasks after installing the cloud
adapters.

For information about postinstallation configuration tasks, see the Oracle Cloud
Adapters Postinstallation Configuration Guide.

Disabling Hostname Verification
By default, the WebLogic Server Configuration Wizard sets Hostname Verification to
Bea Hostname Verifier when creating the Oracle SOA Suite and Oracle Service Bus
domains. Hostname Verification must be set to None for the Oracle Eloqua Cloud
adapter to work.

To disable hostname verification.

1. Log in to the Oracle WebLogic Server Administration Console.

2. Under Domain > Environment > Servers, double-click the server name.

3. Click the SSL tab.

4. Under Advanced, update Hostname Verification to None.

5. Save the change.

Note:   If the domain has one administration server and one managed server,
both servers must have Hostname Verification set to None.

Obtaining the Authentication Credentials
Obtain the user name and password that are required for creating the Credential Store
Framework (CSF) authentication key in Oracle JDeveloper and Oracle Enterprise
Manager Fusion Middleware Control from your SOA domain administrator. These
credentials are required for most cloud adapters. For the Oracle Eloqua Cloud adapter,
the credentials require three properties (company, username, and password).

Unsupported Features
The adapter does not support the following features:

• Adapter runtime retry configuration properties such as jca.retry.count,
jca.retry.backoff, jca.retry.interval, and jca.retry.maxInterval

Installing the Cloud Adapters
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• Message recovery in the Error Hospital in Oracle Enterprise Manager Fusion
Middleware Control

• Rejected message handling

• The following message encryption and decryption features available when you
right-click a cloud adapter in the Exposed Service swimlane or External
References swimlane in Oracle JDeveloper:

– Protect Sensitive Data > Encrypt Request Data for cloud adapters in the
Exposed Service swimlane.

– Protect Sensitive Data > Decrypt Sensitive Data for cloud adapters in the
External References swimlane.

Unsupported Features
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2
Understanding Oracle Eloqua Cloud

Adapter Features

The Oracle Eloqua Cloud adapter provides the following features.

Topics

• Designing an Integration with the Adapter Configuration Wizard

• Monitoring Your Application During Runtime

Designing an Integration with the Adapter Configuration Wizard
You use the Adapter Configuration Wizard to include the Oracle Eloqua Cloud
adapter in a SOA composite application or an Oracle Service Bus business service.

The Adapter Configuration Wizard consists of configuration pages that enable you to
select the artifacts required to communicate with the Oracle Eloqua Cloud application.
You can configure the adapter in the outbound (target) direction.

The Basic Info page prompts you to enter a meaningful name and optional
description.
 

 
The Connection page prompts you to specify the security policy and authentication
key to use. The authentication key is created by clicking the Add icon to specify the
key name, Eloqua company name, user name, and password. You must also specify
these same values in Oracle Enterprise Manager Fusion Middleware Control. For
instructions, see the Oracle Cloud Adapters Postinstallation Configuration Guide
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The Operations page prompts you to select the accounts or contacts business object
and select the field the Oracle Eloqua Cloud adapter uses to match your data to its
data. Choose a unique field to avoid updating the wrong record. To avoid errors, do
not use a large text field. All fields in the Available section are selected by default. You
cannot select only some of them.
 

 
The Summary page displays your selections for the outbound direction.
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The following artifacts are created for each adapter instance in the Applications
window in Oracle JDeveloper:

• WSDL file: Only the standard WSDL file type is supported.

• JCA file: Contains the internal implementation details used by the adapter during
runtime. It contains the different interaction and connection properties used by the
adapter.

When application configuration is complete, you can deploy the application from
Oracle JDeveloper to the runtime environment.

For information about the details to specify in the fields of the wizard pages, see 
Configuring Oracle Eloqua Cloud Connection Properties.

Monitoring Your Application During Runtime
This section describes the design time and runtime aspects of using the Oracle Eloqua
Cloud adapter.

You use the runtime part of the adapter for delivering the information generated
during design time to the service endpoint. You can monitor your SOA composite
application or Oracle Service Bus business service from Oracle Enterprise Manager
Fusion Middleware Control. You can also test your Oracle Service Bus business
service from Oracle Service Bus Console.

Monitoring Your Application During Runtime
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3
Designing SOA Composite Applications

This section describes how to design a SOA composite application with the Oracle
Eloqua Cloud adapter.

Topics

• Creating a SOA Composite Application

• Adding an Adapter to a SOA Composite Application as a Reference

• Completing Design of a SOA Composite Application

Creating a SOA Composite Application
This section provides an overview of how to create a SOA composite application in
which to include the adapter as an exposed service or external reference.

1. Start Oracle JDeveloper.

2. From the File menu, select New > Application.

3. In the New Gallery dialog, select SOA Application from the Items list, then click
OK. The SOA Create SOA Application wizard is displayed.

4. Specify an application name, and click Next.

5. Specify a project name, and click Next.

6. Select Composite with BPEL Process, and click Finish.

The SOA composite application is displayed for designing in the SOA Composite
Editor.

Adding an Adapter to a SOA Composite Application as a Reference
You can add an Oracle Eloqua Cloud adapter to a SOA composite application as an
outbound (target) reference to the External References swimlane in Oracle
JDeveloper.

1. Go to the Component Palette in your SOA composite application.

2. Go to the Cloud section under Custom/Third Party.

The adapters are displayed.
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3. To create an outbound (target) reference, drag the adapter to the External
References swimlane, and see the following sections that describe the wizard
pages for configuring the adapter.

• Configuring Basic Information Properties

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties

• Configuring Oracle Eloqua Cloud Target Operations Properties

• Reviewing Configuration Values on the Summary Page

Completing Design of a SOA Composite Application
This section provides an overview of how to complete design of your SOA composite
application and deploy the application.

1. Design the remaining contents of your SOA composite application. For example:

Completing Design of a SOA Composite Application
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a. Connect the BPEL process to the adapter. For this example, the BPEL process is
connected to the adapter as an external reference:

b. Design the contents of the BPEL process. For example:

i. Double-click the BPEL process.

ii. Add and configure an invoke activity to invoke the adapter.

iii. Add and configure assign activities to copy the contents of one variable to
another when sending and receiving messages to and from the adapter.

iv. Add and configure other activities, as appropriate.

When complete, view the SOA composite application in the SOA
Composite Editor.

For specific information about creating and designing SOA composite applications,
see Developing SOA Applications with Oracle SOA Suite.

2. Deploy the SOA composite application:

Note:   You cannot use Oracle JDeveloper to deploy a SOA composite
application to Oracle SOA Suite Cloud Service. For information about other
deployment options, see Using Oracle SOA Suite Cloud Service.

a. In the navigator, right-click the project and select Deploy > project_name.

b. Follow the steps in the deployment wizard to deploy the SOA composite
application to the application server.

Completing Design of a SOA Composite Application
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4
Designing Oracle Service Bus Business

Services

This section describes how to design an Oracle Service Bus business service with the
adapter in Oracle JDeveloper.

Topics

• Creating an Oracle Service Bus Business Service

• Adding an Adapter to a Business Service as a Reference

• Completing Design of an Oracle Service Bus Business Service

Creating an Oracle Service Bus Business Service
This section provides an overview of how to create an Oracle Service Bus business
service in which to include the adapter in Oracle JDeveloper.

1. Start Oracle JDeveloper.

2. From the File menu, select New > Application.

3. In the New Gallery dialog, select Service Bus Application from the Items list, then
click OK.

4. Specify an application name, and click Next.

5. Specify a project name.

6. Select Service Bus, and click Finish.

The Oracle Service Bus business service is displayed for designing in the Oracle
Service Bus Overview Editor.

Adding an Adapter to a Business Service as a Reference
You can add the adapter to an Oracle Service Bus business service as an outbound
(target) external service to the External Services swimlane in Oracle JDeveloper.

1. Go to the Component Palette in your Oracle Service Bus business service.

2. Go to the Cloud section under Service Bus.

The adapters are displayed.
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3. To create an outbound (target) external service, drag the adapter to the External
Services swimlane, and see the following sections that describe the wizard pages
for configuring the adapter:

• Configuring Basic Information Properties

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties

• Configuring Oracle Eloqua Cloud Target Operations Properties

• Reviewing Configuration Values on the Summary Page

Completing Design of an Oracle Service Bus Business Service
This section provides an overview of how to complete design of your Oracle Service
Bus business service and deploy the application.

1. Design the contents of your Oracle Service Bus business service. For example, to
configure an Oracle Service Bus proxy service in your business service:

a. In the Oracle Service Bus Overview Editor, right-click the Pipeline/Split Joins
lane and select Insert > Pipeline.

The Create Pipeline Service dialog is displayed.

b. Enter a name for the pipeline and select the project location, then click Next

c. Select WSDL as the Service Type.

Completing Design of an Oracle Service Bus Business Service
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d. To the right of the WSDL selection, click the Browse icon to select the WSDL.

e. Select Application.

f. Expand Resource Chooser and select the WSDL file, then click OK.

g. Ensure that Expose as a Proxy Service is selected.

h. From the Proxy Transport list, select http, then click Finish.

The Pipeline component is displayed in the Oracle Service Bus Overview
Editor.

i. Connect the external service to the Pipeline component.

For more information about creating and designing an Oracle Service Bus business
service, see Developing Services with Oracle Service Bus.

2. Open the pipeline that shows the default routing.

3. Verify the service and corresponding operation are displayed in the Routing
Properties tab at the bottom of the dialog.

The outbound project is ready for deployment.

4. Deploy the business service.

Note:   You cannot use Oracle JDeveloper to deploy a business service to
Oracle SOA Suite Cloud Service. For information about other deployment
options, see Using Oracle SOA Suite Cloud Service.

a. Select the project, then select Deploy to Service Bus Server.

b. Follow the steps in the deployment wizard.

Completing Design of an Oracle Service Bus Business Service
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5
Configuring Oracle Eloqua Cloud

Properties

The following sections describe the wizard pages that guide you through
configuration of the Oracle Eloqua Cloud adapter as a target in an integration. The
Oracle Eloqua Cloud adapter cannot be configured as a source in an integration.

Topic

• Configuring Basic Information Properties

• Configuring Oracle Cloud Adapter Connection and CSF Key Properties

• Configuring Oracle Eloqua Cloud Target Operation Properties

• Reviewing Configuration Values on the Summary Page

For more information about Oracle Eloqua Cloud, see Oracle Eloqua Cloud.

Configuring Basic Information Properties
You can enter a name and description on the Basic Info page of each source and target
adapter in your integration.

Topics

• What You Can Do from the Basic Info Page

• What You See on the Basic Info Page

What You Can Do from the Basic Info Page
You can specify the following values on the source or target Basic Info page. The Basic
Info page is the initial wizard page that is displayed whenever you drag an adapter to
the source or target area.

• Specify a meaningful name.

• Specify a description of the responsibilities.
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What You See on the Basic Info Page
The following table describes the key information on the Basic Info page.

Element Description

What do you want to call your endpoint? Provide a meaningful name so that others can
understand the connection. For example, if
you are creating a source Oracle RightNow
Cloud connection, you may want to name it
RightNowInboundDirection. You can
include English alphabetic characters,
numbers, underscores, and dashes in the
name. You cannot include the following:
• Blank spaces (for example, My RightNow

Connection)
• Special characters (for example,  #;83& or

righ(t)now4)
• Multibyte characters

What does this endpoint do? Enter an optional description of the
connection’s responsibilities. For example:
This connection receives an

inbound request to synchronize

account information with Oracle

Sales Cloud.

Configuring Oracle Cloud Adapter Connection and CSF Key Properties
Enter the Oracle Cloud adapter configuration connectivity and Credential Store
Framework (CSF) key values for your integration.

Topics

• What You Can Do from the Oracle Cloud Adapter Connection Page

What You See on the Oracle Cloud Adapter Connection Page

• What You Can Do from the Oracle Cloud Adapter CSF Key Page

• What You See on the Oracle Cloud Adapter CSF Key Page

What You Can Do from the Oracle Cloud Adapter Connection Page
You can specify the following connection values for the Oracle Cloud adapter.

• Specify the WSDL URL for some adapters. If you are configuring the Oracle Eloqua
Cloud adapter, no WSDL is required.

• Specify the security policy.

• Create the authentication key. A key created for one direction (for example,
outbound) is also available for selection in the other direction (for example,
inbound).

Configuring Oracle Cloud Adapter Connection and CSF Key Properties
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What You See on the Oracle Cloud Adapter Connection Page
The following table describes the key information on the Oracle Cloud adapter
Connection page.

Element Description

WSDL URL Note: This field is not displayed for the
Oracle Eloqua Cloud adapter.

Specify the WSDL. The WSDL is used to
build integrations specific to your instance.
You can also select the WSDL from a file
system or another source by choosing the
browser icon next to the WSDL URL field.
Click File System at the top of the dialog,
then browse for the WSDL.

Security Policy Select the security policy appropriate to your
environment (for example,
USERNAME_PASSWORD_TOKEN).

• The wizard shows all policies, including
those that may not be applicable. To make
a correct selection, you must have a
knowledge of policies. For example, you
cannot select a SAML-based policy
because the identity is not propagated.

• The policies you apply to the cloud
adapter are unique to the cloud adapter
and do not impact other endpoints in the
composite.

Authentication Key Select the CSF authentication key.

• Add: Click to create a new authentication
key. You must specify the key name, user
name, and password. To successfully
deploy and administer your application,
you must specify these same values in
Oracle Enterprise Manager Fusion
Middleware Control.

• Edit: Click to edit an authentication key.
• Delete: Click to delete an authentication

key.

Test Click to validate the authentication key.

What You Can Do from the Oracle Cloud Adapter CSF Key Page
You can specify the following CSF key values for the Oracle Cloud adapter.

• CSF key name

• Company name for the Oracle Eloqua Cloud adapter only.

• User name and password

Configuring Oracle Cloud Adapter Connection and CSF Key Properties
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What You See on the Oracle Cloud Adapter CSF Key Page
The following table describes the key information on the Oracle Cloud adapter CSF
Key page.

Element Description

CSF Key Name Specify the CSF key to enable runtime
injection of credentials. The adapter uses the
CSF to retrieve the username and password
required for authentication with the
application (for example, the Oracle Sales
Cloud or Oracle HCM application). This key
identifies your login credentials during
design-time. To successfully deploy and
administer your application, you must
specify these same values in Oracle
Enterprise Manager Fusion Middleware
Control. For instructions, see the Oracle Cloud
Adapters Postinstallation Configuration Guide.

Company Name Note: This field is only displayed for the
Oracle Eloqua Cloud adapter.

Specify the Oracle Eloqua company name.

User Name Enter the user name for connecting to your
application (for example, the Oracle Sales
Cloud or Oracle HCM application). Your
administrator provides you with user
credentials.

Password Enter the password for connecting to your
application.

Re-enter Password Re-enter the same password a second time.

Configuring Oracle Eloqua Cloud Target Operation Properties
Enter the Oracle Eloqua Cloud target operation values for your integration.

Topics

• What You Can Do from the Oracle Eloqua Cloud Target Operations Tab

• What You See on the Oracle Eloqua Cloud Target Operations Tab

What You Can Do from the Oracle Eloqua Cloud Target Operations Page
You can specify the following target operation values for the Oracle Eloqua Cloud:

• Select business objects (accounts or contacts).

• Select the unique identifier field.

Configuring Oracle Eloqua Cloud Target Operation Properties
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What You See on the Oracle Eloqua Cloud Target Operations Page
The following table describes the key information on the Oracle Eloqua Cloud target
Operations page.

Element Description

Cloud Operation Displays the operation to perform. The
currently supported operation is import. This
means that the Oracle Eloqua target imports
data into the connected Oracle Eloqua Cloud
application.

Business Object Type Select the business object for the Oracle
Eloqua target to import into the Oracle
Eloqua Cloud application. This enables you
to synchronize the business object data from
a source system (such as Oracle RightNow
Cloud or Oracle Sales Cloud) to the targeted
Oracle Eloqua Cloud application.

• Accounts

• Contacts

Select Fields This feature is not currently available. Select the
fields of the business object that you want to
send to the Oracle Eloqua Cloud application
as part of the import operation.

Uniquely Match on Field Select the field that the Oracle Eloqua Cloud
application uses to match your data to the
existing data in the Oracle Eloqua
application. Select a field that is likely to be
unique to avoid updating the wrong record.

Do not use a large text field because this can
potentially produce errors.

Auto-Synch Time Interval This feature is not currently available. Select the
time interval between data synchronizations.
The Oracle Eloqua Cloud connection uses this
interval to synchronize data with the Oracle
Eloqua Cloud application.

Reviewing Configuration Values on the Summary Page
You can review the specified source or target adapter configuration values on the
Summary page.

Topics

• What You Can Do from the Summary Page

• What You See on the Summary Page

Reviewing Configuration Values on the Summary Page
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What You Can Do from the Summary Page
You can review source or target configuration details from the Summary page. The
Summary page is the final wizard page for each adapter after you have completed
your configuration.

• View the configuration details you defined for the source or target adapter. For
example, if you have defined an inbound Oracle RightNow Cloud source adapter
with a request business object and immediate response business object, specific
details about this configuration are displayed on the Summary page.

• Click Done if you want to save your configuration details.

• Click a specific tab in the left panel to update your configuration definitions.

What You See on the Summary Page
The following table describes the key information on the Summary page.

Element Description

Summary Displays a summary of the source or target
configuration values you defined on previous
pages of the wizard. To return to a previous
page to update any values, click the
appropriate tab in the left panel.

Reviewing Configuration Values on the Summary Page
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6
Managing Applications

This section describes how monitor an Oracle SOA Suite or Oracle Service Bus
application that uses the adapter from Oracle Enterprise Manager Fusion Middleware
Control or Oracle Service Bus Console and how to verify results in the Oracle Eloqua
Console.

Topics

• Managing the Application in Oracle Enterprise Manager Fusion Middleware
Control

• Testing Oracle Service Bus Projects from Oracle Service Bus Console

• Verifying Results from the Oracle Eloqua Console

Managing the Application in Oracle Enterprise Manager Fusion
Middleware Control

You manage the SOA composite application or Oracle Service Bus business service
that includes your adapter in Oracle Enterprise Manager Fusion Middleware Control.

1. Log in to Oracle Enterprise Manager Fusion Middleware Control.

2. In the navigator, expand the tree to display your SOA composite application or
Oracle Service Bus business service project (for this example, a SOA composite
application is selected).

3. Select the SOA composite application.
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4. Click Test.

The Test Web Service page is displayed.

5. Complete the fields on the page to initiate a test of your composite.

6. Click Test Web Service.

Invocation results are displayed.

7. Click Launch Flow Trace to view the flow trace of the SOA composite application,
including flow details about the adapter.

For more information about monitoring applications from Oracle Enterprise
Manager Fusion Middleware Control, see Administering Oracle SOA Suite and Oracle
Business Process Management Suite and Administering Oracle Service Bus.

Testing Oracle Service Bus Business Services from Oracle Service Bus
Console

You can test Oracle Service Bus business service projects from Oracle Service Bus
Console.

1. Log in to Oracle Service Bus Console.

2. In the navigator under All Projects, open the project to test.

Testing Oracle Service Bus Business Services from Oracle Service Bus Console
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3. In the navigator, click the business service for that project.

4. Click the Launch Test Console (green arrow button) to test the outbound endpoint.

This opens a window that displays the proxy service and the operation to test.

5. Provide the input and click Execute.

This sends the payload to the Oracle Cloud application. The response is displayed
under the Response Document section.

For more information about testing Oracle Service Bus business service projects,
see Administering Oracle Service Bus.

Verifying Results from the Oracle Eloqua Console
You can view results of your application from the Oracle Eloqua Console. For this
example, an Oracle Eloqua Cloud adapter is defined as an external reference in a SOA
composite application. The Oracle Eloqua Cloud adapter inputs an account into the
Oracle Eloqua application. When the application is invoked form the Test Web Service
page in Oracle Enterprise Manager Fusion Middleware Control, you can view account
details in the Oracle Eloqua Console.

1. Log in to the Oracle Eloqua Console.

https://login.eloqua.com/

2. Enter the same company, user name, and password that you entered when
specifying the CSF authentication keys in Oracle JDeveloper and Oracle Enterprise
Manager Fusion Middleware Control.
 

 

3. Select Contacts , then select Accounts.
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4. Specify the account for which to search, and click the Search icon. For this example,
Oracle India-B is specified.

Test results are displayed that include Oracle India-B as the Company Name .
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7
Troubleshooting and Error Handling

This section describes how to troubleshoot and handle errors with the adapter.

Topics

• Test Connection Failure or Operation Page Does Not Open

• Verifying Installation of the Cloud Adapter in Oracle JDeveloper

• Verifying Installation of the Cloud Adapter on Oracle WebLogic Server

Test Connection Failure or Wizard Operation Page Does Not Open
If you receive a test connection failure on the Connection page or the Operation page
does not display in the Adapter Configuration Wizard, perform the following steps:

• Log in to Eloqua directly and see if the credentials work and the Eloqua application
is not down for maintenance.

• The Eloqua user credentials specified must be part of the required security groups
and must have required permissions to make Bulk API calls.

Verifying Installation of the Cloud Adapter in Oracle JDeveloper
Follow these steps to verify the installation of the Oracle Cloud adapter in Oracle
JDeveloper.

• Open Oracle JDeveloper and check for the presence of the Oracle Cloud adapter in
the component palette. Alternatively, you can navigate to the following location:

{MIDDLEWARE_HOME}/soa/plugins/jdeveloper/extensions.

• Check for the oracle.cloud.adapter.eloqua.jar file.

• If you are not able to verify the above step, your installation was not successful. Try
to install the patch again.

Verifying Installation of the Cloud Adapter on Oracle WebLogic Server
Follow these steps to verify the installation of the Oracle Cloud adapter on Oracle
WebLogic Server.

• Use the FTP Client or Putty to connect to the WebLogic server where OPatch has
been installed.

The latest OPatch installs eloqua.jar under the modules directory structure:
{MIDDLEWARE_HOME}/soa/soa/modules/oracle.cloud.adapter_12.1.3/.
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• If you are not able to verify the above step, your installation was not successful. Try
to install the patch again.

Verifying Installation of the Cloud Adapter on Oracle WebLogic Server
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